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Administration Guide 

This guide has been created for IT administrators to assist in installing, 

configuring, and deploying Browsium Ion. This is version of the guide is designed 

for use with Browsium Ion 3.2. 

 

For more information about Browsium, or to contact customer support, please 

visit http://www.browsium.com.  

http://www.browsium.com/
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Section One 

Introduction 

 

In this section you will learn: 

 Why Browsium Ion is your one-stop Web Application Continuity framework 

 What components make up the Browsium Ion system 

 How you can seamlessly integrate Browsium Ion into your enterprise 
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1. Introduction 

Many organizations would like to upgrade to a modern version of Internet Explorer and 

Windows 7 or Windows 8, but can’t. That’s because they depend upon web applications which 

were designed for legacy versions of Internet Explorer. The various changes in layout, rendering, 

scripting and security designs in modern IE versions prohibit those applications from functioning 

properly without extensive and expensive modifications or upgrades.  

Browsium Ion (“Ion”) allows enterprises to upgrade to modern technologies like Windows 7 or 

Windows 8 and current Internet Explorer versions while maintaining compatibility with existing 

legacy web applications–all without changing a single line of server code.  

But Ion provides more than just legacy Internet Explorer compatibility for the web applications 

you are running today – it helps ensure Web Application Continuity as your business moves 

forward. Web Application Continuity provides solutions to manage, maintain, and operate your 

web applications regardless of the underlying browser lifecycle. Your web applications are built 

to serve the business for years, but the rate of browser innovation has accelerated to the point it 

outpaces the standard IT technology system lifecycle.  

Ion decouples the browser/web application dependencies that exist today, and enables your 

organization to deploy technologies when you want, without breaking existing line-of-business 

applications. More importantly, Ion is seamless to users, integrated into the browser and is more 

easily managed than virtualization solutions. 
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1.1. Browsium Ion Overview 

Ion delivers Web Application Continuity by delivering the ability to use and control multiple 

browser modes, fully customize the browsing environment, and rollback web plugin support to 

legacy versions all inside modern versions of Internet Explorer. Ion lets organizations enjoy the 

features and better security of the latest platforms and migrate their legacy Internet Explorer 

applications on their own timeframes and budgets.  

More importantly, Ion is a solution that makes sense.  

Ion makes sense to users because it’s seamless. It lets them work in the ways they’re used to, 

unlike virtualization approaches that require special training or hardware. In fact, many users 

never notice they’re using Ion. 

Ion certainly makes sense to IT administrators because it’s been designed with them in mind. Ion 

is easy to deploy and manage using the same tools and techniques they use for Internet 

Explorer. There’s no server component, so Ion works well for in-house and remote workers alike. 

With minimal overhead, and support for 32- and 64-bit versions of Windows, Ion runs 

everywhere IT administrators need it to. Finally, it’s isolated approach to running legacy browser 

settings greatly reduces attack surface when compared to running a legacy operating system 

and browser. 

With Ion integrated into your business, the security and functionality benefits of Windows 7, 

Windows 8, and a modern Internet Explorer are no longer out of reach. 
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1.2. Browsium Ion Explained 

Browsium Ion is markedly different from any other web application compatibility offerings, so to 

understand what Ion is, it’s easiest to start by identifying what it is not: Ion is not virtualization, it 

is not a repackaged standalone version of Internet Explorer, nor is it a solution that enables 

running multiple versions of the Internet Explorer browser on the same Windows installation. 

Installing Ion on your system does not modify the default system browser registry values or 

settings.  

Ion is controlled by a hierarchical system of Profiles and Rules, defined using the Ion 

Configuration Manager. Understanding this system is the key to understanding Ion. The 

Configuration Manager provides the configuration tool that allows Ion to sidestep compatibility 

issues by delivering different versions of rendering modes, registry settings and ActiveX controls 

to the web applications that need them. And with the custom ActiveX, File and Registry settings 

feature, you can manage browser extensions that are otherwise incompatible with a particular 

version or architecture of Windows or Internet Explorer. 

Ion works by managing the way your natively installed version of Internet Explorer renders 

content. When invoked automatically by a Rule, Ion ensures web applications load the needed 

version of an add-on, inject the proper JavaScript code, and carry forward legacy Internet 

Explorer environment and security settings – all without modifying the Windows and Internet 

Explorer installations or reducing the security posture of the system. Ion renders legacy web 

applications and content directly inside the Internet Explorer window, just like any other content 

in the browser. Ion is fully integrated with Internet Explorer settings and uses existing browser 

settings and file system setups so you only need to manage the exceptions. This approach 

requires fewer resources and makes administration easy.  

More specifically, Ion acts as a broker between the browser and the requested web content. Ion 

uses software isolation to display content and settings on an IT-controlled opt-in basis. In other 

words, Ion intervenes when – and only when – it is told to by IT administrators. 

1.2.1. Document Modes  

Document modes are the foundation of how Ion is able to make legacy applications work. When 

a user requests a page that matches an Ion rule, Ion displays the content using an alternate 

document mode specified by that rule. The following document modes are available in Ion 3: 

 Default (let Internet Explorer choose) 

 Adaptive IE Quirks Mode (combination of IE Quirks Mode and IE7 Standards Mode) 

 Emulate IE7 Mode 
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 Emulate IE8 Mode 

 Emulate IE9 Mode 

 Emulate IE10 Mode 

 IE Quirks Mode 

 IE Edge Mode 

 IE7 Standards Mode 

 IE8 Standards Mode 

 IE9 Standards Mode 

 IE10 Standards Mode 

1.2.2. Profiles  

Profiles are groups of settings and browser configurations as well as the specific environment 

settings, options/values and add-ons required for your web application. Profiles let you specify 

the configuration and settings needed to run your web application properly, even if that 

configuration varies from the default IE installation or settings. By providing this type of ‘side by 

side’ rendering environment, Ion ensures web applications run as expected, even when the 

default system settings and applications are upgraded to the latest modern IE version. 

Profiles are easy to create and customize for your specific web application needs. To get started 

with Profiles, simply select the browser engine required for your web application and Ion will 

create a Profile using that browser engine and commonly required default settings. From there 

you can add Custom File associations (to fix issues like running multiple versions of Java inside 

Internet Explorer or load older CRM/ERP application controls), define HTTP Headers (to ensure 

web applications operate correctly), as well as a range of other options.  

While Profiles are highly customizable, they also inherit system settings that are not explicitly 

changed. This streamlines management by ensuring you don’t need to recreate every policy 

setting and control point; simply manage the ones you need to set for compatibility. 

Information on the specifics of each browser engine available in Ion can be found in the Profiles 

List section. 

1.2.3. Rules 

Rules are actions triggered by a simple string or IP address match or more complex and granular 

regular expressions. Rules provide very granular control over the conditions which bring them 

into play, and can work broadly against entire zones or target specific elements on a page. See 

the Rules Manager section to learn more. 
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1.3. Ion Configuration Manager 

The Ion Configuration Manager is the main interaction point for IT administrators using the Ion 

system. Designed to work efficiently in your business and deploy using your existing technology 

systems, the Ion Configuration Manager can be utilized in ways that best meet the needs of your 

organization. Using a distributed architecture approach, each web application team – or 

business unit – can use the Ion Configuration Manager to create Rules and configurations for 

their specific needs; alternatively, a single administrator can manage all the Rules, Profiles and 

Settings.  

If you choose the distributed approach, you can merge configurations so users will have the 

combined set of rules and configurations needed for Line of Business application compatibility. 

Using the Ion Configuration Manager, define the sites that need a specific engine and Profile, 

define and deploy the necessary Rules and those sites will then be loaded in Internet Explorer 

and rendered using the Ion add-on technology. By integrating with Internet Explorer, Ion 

provides a seamless and natural browsing user experience. Your users won’t need to know they 

are viewing sites through Ion – things will just work. 

This is the power of Ion: You control the behavior. Only the sites you configure with the Ion 

Configuration Manager are displayed using the Ion add-on. You can then easily export 

configurations settings as Flat Files (in an easy to read XML format) to ensure interoperability 

with virtually any software management infrastructure, including Group Policy. 
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1.4. Browsium Ion Integration with Internet Explorer 

Unlike any other web application compatibility solution available today, Browsium Ion is fully 

integrated inside Internet Explorer. Ion is a clean and user-friendly solution that enables a single 

browser to access both legacy web applications and the latest standards-based web 

technologies. Integration with Internet Explorer increases user efficiency and reduces help desk 

calls by eliminating user confusion when working with multiple browsers or virtualized systems. 

In addition to being a better solution for end users, Ion offers many benefits for the IT 

administrator. As an integrated component of Internet Explorer, Ion reduces installation and 

patch management overhead, by using Internet Explorer’s local settings and configurations.  

Internet Explorer Group Policy Options (GPOs) ‘cascade’ down and are respected by Ion, so you 

only need to manage one set of policies. In cases where a Group Policy setting controls a feature 

not supported by the rendering engine specified by a rule, Ion simply ignores the setting. This 

ensures consistency across systems running Ion, even in environments that have not 

standardized on a single version of Internet Explorer, and avoids limitations or issues that may 

arise in future versions of Internet Explorer.
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Section Two 

Installation 

 

In this section you will learn: 

 About the Browsium Ion System Components 

 Software Requirements for Browsium Ion 

 How to Install Browsium Ion 

 How to Configure Command Line Switches for Network Distribution 
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2. Installation 

Browsium Ion is simple to install – administrators need both the Browsium Ion Configuration 

Manager and the Ion Client, while end users only need the Ion Client installed. The Browsium Ion 

Client requires Administrator permission to install, but can run using standard user permissions 

so system access can remain tightly controlled. This section provides details on the specific 

pieces of the Ion system as well as information on how to manage the Ion Client installation in a 

corporate environment.  
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2.1. Ion Components 

The Ion system is comprised of two main components: an administrative tool for defining 

configurations, and a client for interpreting the configurations for end users.  

 Ion Configuration Manager (Ion-AdminSetup.exe) 

The Ion Configuration Manager (CovManager.exe) is the single management interface 

for the Ion system. This application provides the central point for creating, configuring 

and managing Projects, Profiles and Rules. Since the Ion Configuration Manager is not 

meant for end users, this package should not be installed broadly – installation of this 

package should be limited to system administrators and web application/business unit 

owners. 

 

 Ion Client (Ion-ClientSetup.msi) 

The Ion Client is responsible for loading Ion configuration data and invoking Ion-

managed instances of Internet Explorer for end-users. The client package must be 

installed on all PCs in your organization that require web application remediation with 

Ion. The Ion Client consists of two core components: 

 

o Ion Controller & Broker 

The Ion Controller (CovController.exe) is the main component of the client 

infrastructure used by Ion to handle content loading, rules implementation and 

redirection. The Ion Broker (CovBroker.exe) handles communication between 

the Ion Controller and Ion-managed instances of Internet Explorer. The Ion 

Monitor (CovMonitor.exe) is responsible for ensuring that Controller is running 

reliably. 

 

o Ion Client Add-On for Internet Explorer 

Ion installs an add-on to facilitate communication between Internet Explorer and 

the Ion Controller and Ion Broker. 
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2.2. Software Requirements 

The following minimum system specifications are required to run Browsium Ion. 

 Microsoft Windows System  

o Windows XP 

o Windows 7 

o Windows 8 

o Windows Server 2003 

o Windows Server 2008 R2 

o Windows Server 2012 R2 

 Microsoft Internet Explorer 8, 9, 10, or 11 

 .NET Framework Version 3.5 

 1GB system memory 

o 2GB system memory when used on multi-user Windows Servers 

While Browsium Ion can be installed on systems with less than 1GB of memory, 

users may experience performance issues. 
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2.3. Installing the Browsium Ion Client 

This section covers manual installation of the Browsium Ion Client. Network and command line 

installation options can be found in Available Command Line Switches for the Installer. You will 

need Administrator rights to run the Client Installer. Once installed, the Ion Client can run under 

any user account and does not require special user permissions or elevation. 

1. To start the Client Installer process, double-click on the Ion-ClientSetup.msi file. To 

properly complete the installation process you will need an account with Administrator 

rights. The first screen provides a basic introduction. Click Next to get started. 

 

 

 

Once the installation process has begun, you will be presented with two choices for the 

installation mode. One installs the Ion Client software as a 30-Day Evaluation Kit. The 

second installs the fully licensed version, requiring a license key provided by Browsium. 

When you have completed your 30-Day Evaluation of Ion and are ready to install 

the License, the process is defined in section 2.5.5 Repair Options. 
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If you have chosen the Licensed Version, you may now enter the license key that has 

been provided by Browsium and then click Next. The license key can be copied from 

Browsium Ion Download page and pasted into the empty box. 

 

 

 

Your license key is then validated. An invalid product key will result in the following error: 

 

 

 

If you believe your key is valid, please contact Browsium Support. You may install the 30-

day Evaluation Kit now and update the license key later. Be sure to delete the invalid key 

after clearing the error dialog before clicking Back to the previous screen. 

 

2. The next screen contains the End User License Agreement (EULA) for Browsium Ion 

software. You will need to read and agree to the terms of the EULA in order to proceed. 
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This page allows you to specify where to install the Ion Client program files. When you 

have specified the desired location, click Next. Browsium recommends installing into the 

default location. 

 

 

 

3. Now you are ready to install the Ion Client. Simply click Install to proceed. 

 

During the process you will see a progress bar: 
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When the Ion Client installation process has finished, you will see the following screen 

indicating success. 

 

 

To confirm the Ion installation has completed properly, launch Internet Explorer and select 

Tools->Manage Add-ons to ensure the Browsium Ion Client Add-on is listed and Enabled. 

 

 

 

 

2.4. Installing Browsium Ion Configuration Manager 

This section covers the installation process for the Browsium Ion Configuration Manager. The 

Browsium Ion Client Add-on should be installed on the system in order to create, edit or test 

Rules and Profiles.  

The steps for installing the Ion Configuration Manager are as follows: 

1. Locate the Ion Configuration Manager Installation file (Ion-AdminSetup.msi) and 

double click to run the program. 
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2. Confirm you have read and agreed to the End-User License Agreement (EULA) by 

clicking ‘I agree to the terms in the License Agreement’ and Next to continue with 

installation. 

 

 

 

3. Select the installation type, either for a single user or for all users. The Configuration 

Manager should only be accessible to network and system administrators, so Browsium 

recommends setting the installation type to ‘Only for me’ on most systems. 
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Customers installing the Configuration Manager on a remote desktop/terminal 

services or other shared resource configurations should select ‘Only for me’. The 

Ion Configuration Manager is designed for use only by system or network 

administrators; selecting ‘Everybody’ will install Ion for all users. If installed in a 

shared resource configuration all users would have access to the application. Since 

the Ion Configuration Manager requires Administrator rights to run properly and 

standard users may create support tickets when they experience issues or error 

messages from the application. 

4. If the installation type is set to ‘Only for me’ then by default the installer places the 

required files in "%userprofile%\AppData\Local\Programs\Browsium\Ion 

Manager\"  
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If the installation type is set to ‘Everybody’ then by default the installer places the 

required files in "\Program Files\Browsium\Ion Manager" (32-bit systems) or 

"\Program Files (x86)\Browsium\Ion Manager" (64-bit systems) on the system 

drive. 

 

Select an installation location and click Next. 

 

5. Now you’re ready to install the Ion Configuration Manager. Click Install. 

 

 

The Ion Configuration Manager requires Administrator rights so the installer may 

generate a UAC prompt before installing. 

6. During the installation process you will see a progress window 
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7. This screen will be displayed when the installation is complete and all necessary files 

have been configured. Click Finish and you are ready to begin working with the Ion 

system. 
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2.5. Available Command Line Switches for the Installer 

Ion supports network-based installations using Windows Installer (MSIEXEC.EXE) for 

organizations that use software distribution systems or want to deploy via installation scripts 

and logon applications. Ion provides for several options that are controlled by the following 

switches. Note: You must run Command Prompt as Administrator on Windows 7 and later. 

2.5.1. Installation Options 

Switch Description 

/j<u|m> <Product.msi> [/t <Transform 
List>] [/g <Language ID>] 

Advertises a product – ‘m’ to advertise to all users, 

‘u’ to advertise to the current user 

</uninstall | /x> <Product.msi | 
ProductCode> 

Uninstalls the product 

APPDIR=<path> Installs product to a specific directory, other than 

the default location 

OPT_PID=<license key> Installs with an Ion license key 

2.5.2. Display Options 

Switch Description 

/quiet Quiet mode, no user interaction 

/passive Unattended mode - progress bar only 

/q[n|b|r|f] Sets user interface level, where: 

n - No User Interface 

b - Basic User Interface 

r - Reduced User Interface 

f - Full User Interface (Default) 

/help Shows help information 

2.5.3. Restart Options 

Switch Description 

/norestart Do not restart after the installation is complete 

/promptrestart Prompts the user for restart if necessary 

/forcerestart Always restart the computer after installation 
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2.5.4. Logging Options 

Switch Description 

/l[i|w|e|a|r|u|c|m|o|p|v|x|+|!|*] 
<LogFile> 

Install keeping a log file, where: 

  i - Status messages 

  w - Nonfatal warnings 

  e - All error messages 

  a - Start up actions 

  r - Action-specific records 

  u - User requests 

  c - Initial UI parameters 

  m - Out-of-memory or fatal exit information 

  o - Out-of-disk-space messages 

  p - Terminal properties 

  v - Verbose output 

  x - Extra debugging information 

  + - Append to existing log file 

  ! - Flush each line to the log 

  * - Log all information, except for v and x options 

/log <LogFile> Equivalent of /l* <LogFile> 

2.5.5. Repair Options 

Switch Description 

/f[p|e|c|m|s|o|d|a|u|v] <Product.msi | 
ProductCode> 

Repairs a product 
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2.5.6. Command Line Installation Examples 

The following example will install Ion-ClientSetup.msi with an Ion license key in Quiet Mode with 

No User Interface. Launch the Command Prompt as Administrator, enter the path to Ion-

ClientSetup.msi (located in C:\Browsium for this example), add the /qn switch, and substitute the 

hash marks (#) with your Ion license key provided by Browsium.  

 

The following example will uninstall Ion-ClientSetup.msi in Quiet Mode with No User Interface. 

Launch the Command Prompt as Administrator, enter “msiexec /uninstall” followed by the path 

to Ion-ClientSetup.msi and add the /qn switch. 

 

More information on deploying the Ion Client to ensure the browser extension is enabled by 

default can be found in section 6.4. 

2.6. Upgrading from Evaluation to Licensed Version 

You have two options when your 30-Day Trial is complete and you wish to upgrade your Ion 

Client software to the fully licensed version:  

The first is to enter the license key in the system registry utilizing a registry editing tool 

or command line script. You must have administrator rights to edit the registry. 

For 32-bit systems, the registry key is as follows:  

HKEY_LOCAL_MACHINE\SOFTWARE\Browsium\Ion\Full  

For 64-bit systems, the registry key is as follows: 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Browsium\Ion\Full  

The value data is your license key: ####-####-####-####-####-####-#### 
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The second option is to uninstall the client software with windows Program and Features 

uninstall utility which can be found in Control Panel. Then reinstall Ion-ClientSetup.msi, 

select Licensed Version, click next.  

 

Then enter the license file provided by Browsium and continue with the install process as 

before.  

 

 

You may also install the Ion Client from a command line using the  

OPT_PID=<license key> switch documented in section 2.5. 
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Section Three 

Introduction to  
Ion Configuration Manager 

 

In this section you will learn: 

 More about the Browsium Ion Configuration Manager 

 Where to Find Settings in the Browsium Ion Configuration Manager 

 How to Navigate the Screens, Settings and Options in the Browsium Ion Configuration Manager 
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3. Ion Configuration Manager Overview 

The Ion Configuration Manager enables you to create Profiles and manage Rules that define the 

websites you need to manage using the Ion rendering process. This section looks at the various 

elements of the Ion Configuration Manager. The Configuration Manager is designed with the 

look and feel of an MMC snap-in, with three main functional areas: 

Objects Pane (Left) – Tree view containing Projects andTools Nodes 

Content Pane (Center) – Main data and content window 

Actions Pane (Right) – Contextual links for common tasks and steps 

 

  

In addition to the main functional areas, there is a Menu Bar and Quick Links area to provide 

easy access to commonly used items.  

 

The Quick Links area includes links to launch Internet Explorer, show the Welcome Screen and 

open the Browsium Documentation Center. 

See the Projects Node, Profile Node, Rules Manager Node, Project Settings Node and Tools 

Node sections for a detailed description of each Objects Pane Node. 



 

 

Browsium Ion 3.2 Administration Guide (Revision 04212014)  ©2014 Browsium Inc. 

30 

3.1. Menu Bar 

The Ion Configuration Manager Menu Bar dynamically updates the list of available File menu 

items based on the active Node selected in the Objects Pane. The functions available in the File 

menu can also be found using the right click context menu on a given Node. 

             

To aid in configuration testing and tuning, the Ion Configuration Manager allows Administrators 

to apply settings directly in the local system registry. This option reduces delays and overhead of 

exporting settings to Group Policy by applying those settings and forcing the local machine to 

reload policy values. Settings can be saved to either the Current User (HKCU) or Local Machine 

(HKLM) based on the needs of your organization and whichever choice properly replicates the 

target client system settings for your organization. 

You can use the Utilities menu to launch Internet Explorer and manage the CovController.exe 

(“Controller”) process. You may need to Start/Stop/Restart the Controller in order to load new 

configurations or reproduce troubleshooting steps. 
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3.2. The Projects Node 

The Projects Node displays all configuration files (Projects) loaded in the Ion Configuration 

Manager. An individual Project file (.PROJECT.BCX file extension) contains all of the 

configuration information needed for a given set of Rules and Profiles. Multiple Projects can be 

opened simultaneously and multiple Projects can be saved in a single Project file.  

 

The tree view provides an easy method for working with individual Projects to edit, save and 

export configurations. Items within the Projects Node have right-click context menus that can be 

used as shortcuts for commonly used features such as ‘Save’ or ‘Add Profile’. 

 

  

 

Highlighting the main Projects Node displays the list of available Projects. A specific Project can 

be opened by either double clicking on the item from the Projects List or selecting it from the 

tree view listing.  



 

 

Browsium Ion 3.2 Administration Guide (Revision 04212014)  ©2014 Browsium Inc. 

32 

Loading a Project (or creating a New Project) in the Projects Node inserts the item into the tree 

view and brings up the Project details in the Content Pane. 

 

Project details (Name and Description) can be edited in this screen. Projects are assigned default 

values (New Project, Project Description) and should be edited to reflect information and 

labeling relevant to your organization. 

Use the File menu or right click context menu to Save a Project. To Export the settings to Group 

Policy (either .ADM or .ADMX formats), select the Project and use the File menu option. See the 

Deploy Ion Configurations via Serialized Registry Keys section for more information on this 

feature. 

From here you can select items from the Actions Pane (context sensitive) menus or right click 

any of the items under the Project name. 
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3.3. The Profile Node 

Profiles contain the Browser engine, environment settings and specific Add-ons to be used in 

rendering content. To create a new Profile, right click on the Profiles Node or use the Actions 

Pane ‘Add Profile’ item.  

 

3.3.1. Rendering Mode Selection 

Profiles are based on rendering modes. This screen shows the available Rendering Mode 

templates in Ion: 
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This chart provides a list of the Rendering Modes included by default: 

Rendering Mode Description 

Default  This creates an empty Profile with no Document Mode or 

customized values. All settings are default settings or blank 

values. 

 

Adaptive IE Quirks Mode Renders content by dynamically selecting either the IE7 

Standards or Quirks Mode rendering behavior based on 

the presence and location of a DOCTYPE on the page. 

Pages will be rendered using the IE7 Standards behavior if 

the page contains a DOCTYPE in the 1st position (no text 

preceding the declaration) and that DOCTYPE declaration is 

anything other than ‘QUIRKS’. Pages will be rendered using 

the Quirks Mode behavior if the page has no DOCTYPE 

declaration, expressly includes a QUIRKS DOCTYPE 

declaration or if the DOCTYPE declaration is NOT in the 1st 

position. 

 

In either case the IE6 UA string is declared regardless of 

which rendering Mode is selected. 

 

Emulate IE7 Mode Standards Mode directives are displayed in Internet 

Explorer 7 Standards Mode and Quirks Mode directives are 

displayed in IE5 Mode. 

 

Emulate IE8 Mode Standards Mode directives are displayed in Internet 

Explorer 8 Standards Mode and Quirks Mode directives are 

displayed in IE5 Mode. 

 

Emulate IE9 Mode Standards Mode directives are displayed in Internet 

Explorer 9 Standards Mode and Quirks Mode directives are 

displayed in IE5 Mode. 

 

Note: This Profile will default to the highest available version 

of IE Standards Mode engine on systems running versions 

lower than IE9. E.g. IE8 systems will use IE8 Standards Mode, 

etc. 

 

Emulate IE10 Mode Standards Mode directives are displayed in Internet 

Explorer 10 Standards Mode and Quirks Mode directives 

are displayed in IE5 Mode. 

 

Note: This Profile will default to the highest available version 

of IE Standards Mode engine on systems running versions 

lower than IE10. E.g. IE8 systems will use IE8 Standards 

Mode, IE9 systems will use IE9 Standards Mode, etc. 
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IE Quirks Mode Renders content as if it were displayed in Quirks Mode by 

Internet Explorer. IE Quirks is similar to the rendering 

behavior in IE 5.5. This Profile can be used to force a web 

application to render using ‘Quirks’ Mode directives.  

IE Edge Mode To plan for future browser version continuity, Ion includes 

the ‘Default IE Edge Mode Profile’ to enable rules to always 

use the default (latest) browser engine installed on the 

system.  

 

Note: Ion supports multiple versions of IE (8, 9, 10). 

Customers are advised to use caution in selecting this value 

as it will have important behavioral, rendering and scripting 

differences when used on different Internet Explorer versions.  

 

IE7 Standards Mode Renders content as if it were displayed in Standards Mode 

by Internet Explorer 7. This Profile can enable scenarios 

where a web application renders properly using the IE8’s 

‘IE7 Mode’ but the given line-of-business application may 

require granular setting configurations that are not 

possible or appropriate changes to make globally to the 

IE8 browser configuration. 

 

IE8 Standards Mode Renders content as if it were displayed in Standards Mode 

by Internet Explorer 8. 

 

IE9 Standards Mode Renders content as if it were displayed in Standards Mode 

by Internet Explorer 9. 

 

Note: This Profile will default to the highest available version 

of IE Standards Mode engine on systems running versions 

lower than IE9. E.g., IE8 systems will use IE8 Standards Mode. 

 

IE10 Standards Mode Renders content as if it were displayed in Standards Mode 

by Internet Explorer 10. 

 

Note: This Profile will default to the highest available version 

of IE Standards Mode engine on systems running versions 

lower than IE10. E.g. IE8 systems will use IE8 Standards 

Mode, IE9 systems will use IE9 Standards Mode, etc. 
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Any Profile can be modified to suit specific web application compatibility issues. For example, 

Ion makes it possible to specify different versions of the Java Runtime Environment (JRE) on a 

per-Profile basis, whereas changing the JRE version for Internet Explorer globally would only 

allow for a single version to be loaded at a time. 

 

Care should be used when selecting IE Edge, Emulate IE9, Emulate IE10, IE9 Standards and IE10 

Standards since the rendering engines, and therefore rendering behavior, will be very different 

when the Profile is invoked on systems running Internet Explorer versions lower than the mode 

specified.  

  



 

 

Browsium Ion 3.2 Administration Guide (Revision 04212014)  ©2014 Browsium Inc. 

37 

3.3.2. Profile Editor 

The Profile Editor is used to modify settings, values and configurations for a given Profile. To get 

started, highlight a Profile to view the details in the Content Pane. 

 

Profile details (Profile Name, Profile Description, and Document Mode) can be edited in this 

screen. Profiles are assigned default values based on the Template selected when creating a 

New Profile. Most values can be left at defaults, but Profile Name and Description should be 

edited to reflect information and labeling relevant to your organization. 

3.3.2.1. Profile Editor 
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This list provides an explanation of the items on the Profile Editor screen. Additional information 

about each setting is available from within the Ion Configuration Manager using the ‘rollover’ 

information panel display inside the Content Pane. 

Profile Name – The Profile name is a friendly name for your reference, and can be modified to 

suit your organization.  

Profile Description – The description field provides a place to include a more complete 

explanation of the Profile. 

Document Mode – Ion allows you to define which Document Mode is included for pages 

loaded using the specified Profile. Internet Explorer Document Modes are used to trigger 

different rendering and scripting engine behaviors. The default Document Mode included with 

each Profile is set based on the browser engine selected when the Profile is created. The 

Document Mode can be changed at any time and is exclusive of the browser engine value. More 

information about Document Modes can be found at  

http://msdn.microsoft.com/en-us/library/ie/cc288325(v=vs.85).aspx#DCModes. 

  

http://msdn.microsoft.com/en-us/library/ie/cc288325(v=vs.85).aspx#DCModes
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3.3.2.2. User Agent String Settings 

The User Agent (UA) Settings let you specify the value passed by the browser for a given Profile. 

For example, the default UA string used by IE6 is that of a Windows XP Service Pack 2 system. 

Some common web application compatibility issues can be resolved by simply adjusting the UA 

string values. Using this feature, Profiles can be configured to send the desired UA string 

without impacting the installed Internet Explorer UA string values. UA strings are defined in a 

Profile using the originally selected browser engine template, but the values can be changed at 

any time.  

More information on the User Agent string elements and potential values can be found at 

http://msdn.microsoft.com/en-us/library/ms537503%28v=vs.85%29.aspx. 

 

Ion provides the ability to uniquely and individually define each portion of the UA String value. 

The most commonly adjusted values are Platform and Version. 

As a general rule, Profiles created using any of the rendering mode templates will 

set the UA string values to the minimum supported platform for the Internet 

Explorer release on which that rendering mode is designed. For Example, the UA 

string values for an Emulate IE8 Profile will be set as Windows NT 5.1 (Windows XP 

version number) as IE8 minimum support starts with Windows XP.Platform Token 

Editor. 

  

http://msdn.microsoft.com/en-us/library/ms537503%28v=vs.85%29.aspx
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In addition to the base UA String values, Ion provides a mechanism to specify Pre- and Post-

Platform Token values that are included in the full UA String value. 

 

 

Common uses of the Pre- and Post-Platform Tokens define the installed add-ons and versions. 

Some web applications examine these values for proper functionality so this feature enables 

including the required values. Other web applications are unable to process long UA String 

values and this feature can be used to reduce the set of Pre- and Post-Platform Tokens to a 

manageable level. 
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3.3.2.3. Custom Files Manager 

Ion allows you to create specific file system entries as well as define custom ActiveX controls for 

a Profile. Ion hosts these items internally, so nothing is applied or modified on the system. Any 

required file system entries or ActiveX controls should be defined here.  

 

 

This screen displays all configured Custom File and Custom ActiveX mappings. To add a value, 

use the link in the Actions Pane on the right-hand side or simply right click on the Custom Files 

Manager Node and select the ‘Add Custom File’ option from the context menu. To edit a value, 

highlight the item in the Content Pane and use the ‘Edit Custom File’ link in the Actions Pane or 

the Custom Files Manager right-click context menu. 

New for Ion 3 is the Java Version Manager. This wizard is designed to help automate the 

creation of the Custom Files entries required to run a specific version of Java for your web 

application.  

  



 

 

Browsium Ion 3.2 Administration Guide (Revision 04212014)  ©2014 Browsium Inc. 

42 

3.3.2.3.1. Custom Files Editor 

Use this screen to add or edit Custom File mappings. More information on this feature and an 

example of creating a Custom File mapping can be found in the Working with Custom Files, 

Registry Settings and ActiveX Controls section.  

 

3.3.2.3.2. Java Version Manager 

Using the Java Version Manager is the easiest and fastest way to define specific versions of Java 

for use by your web application. By default, IE and the JRE are designed to use the most recent 

version of Java installed on the machine. The Java Version Manager provides a dropdown list of 

all installed Java versions on the current machine, enabling you to simply select that version and 

the wizard creates the Custom Files entries. More information on this feature and an example of 

creating a Custom Files mapping can be found in the Java Version Manager section. 
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3.3.2.4. Custom Registry Manager 

This screen allows you to create specific registry entries for a Profile. Ion provides an 

environment to host these items internally, so nothing is applied or modified on the system. Any 

required registry entries should be defined here.  

 

To add a value, use the link in the Actions Pane on the right hand side or simply right click on 

the Custom Registry Manager Node and select the ‘Add Custom Registry Entry’ option from the 

context menu. To edit a value, highlight the item in the Content Pane and use the ‘Edit Custom 

Registry Entry’ link in the Actions Pane or the Custom Registry Manager right-click context 

menu. 
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3.3.2.4.1. Custom Registry Value Editor 

Any type of Registry entry can be created using this interface. Simply choose the Hive location 

and entry values, and then click OK. 

 

For more information on working with Custom Registry settings, see the Working with Custom 

Files, Registry Settings and ActiveX Controls section. 
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3.3.2.5. HTTP Header Manager 

This screen displays the list of defined Custom HTTP headers. HTTP header fields are 

components of the message header of requests and responses and some web applications rely 

on these headers to trigger certain behaviors and functionality. Ion enables easy creation and 

management of HTTP Headers. 

 

A list of available HTTP Header fields can be found at 

http://en.wikipedia.org/wiki/List_of_HTTP_header_fields . To add an HTTP Header, use the link in 

the Actions Pane on the right-hand side or simply right click on the HTTP Header Manager 

Node and select the ‘Add Header’ option from the context menu. To edit a value, highlight the 

item in the Content Pane and use the ‘Edit Header’ link in the Actions Pane or the HTTP Header 

Manager right-click context menu. 

  

http://en.wikipedia.org/wiki/List_of_HTTP_header_fields
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3.3.2.6. Content Override Manager 

Some older web applications may include content (JavaScript, HTML, CSS, images, etc.) resulting 

in compatibility issues with newer browser rendering engines that cause the application to work 

incorrectly. These issues can be as simple as layout issues, more complex coding related issues 

that prevent the site from loading or even serious issues that cause the web browser to crash 

when loading specific content. 

 

Ion provides the ability to replace or block inline or linked content for a given web page to help 

solve these compatibility issues. 
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3.3.2.6.1. Content Override Editor  

Start by defining the Target URI – even though these settings are part of a Profile which would 

be triggered by a Rule, Content Overrides have an additional layer of granularity and work with 

content regardless of the location so the Target URI must be specified for the content being 

replaced. 

 

The Content Override feature provides the ability to control the loading behavior taken by the 

browser for the specified content. The available Actions are: 

 Block: Stops the content from being downloaded. 

 URL (Default): Redirects the request for the content at the specified URI to the URL 

specified in the Data field. 

 File – Body Only: Loads content from the file specified in the Data field. 

 File – Header and Body: Loads content from headers and the file specified in the Data 

field. 

 Content: Replaces content from the specified URI with the content in the Data field. 

 

The Data field will contain content based on the selected Action. 

While Ion is not sold as a security solution, the Content Override feature can be 

used to prevent downloading known malicious or restricted content. 

3.3.2.7. String Replacement Manager 

Some older web applications need simple, targeted fixes to make an application work exactly 

right. Often the issues can be as simple as resizing an image or changing a word in some 

JavaScript. Changing the web application source code is a great way to go – but many 
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organizations are using ‘off the shelf’ applications for which they don’t have source code access 

to change what is needed. Some commercial applications have license agreements that prohibit 

any modification to their source code or binaries. In addition, changing the source code is 

impractical for ‘roll outs’ where some users will remain on older browsers while some users get 

the latest versions. 

Ion offers the ability to edit text ‘inline’ before the browser rendering begins, enabling an 

organization to fix virtually any issue without touching the source code. These changes are 

highly targeted and can be used to make pinpoint changes to the affected area of the web 

application. 

 

Making a string replacement is easy. Start by defining the Target URI – even though these 

settings are part of a Profile which would be triggered by a Rule, String Replacements are 

designed to work with content regardless of the location so the Target URI must be specified for 

the strings being replaced. 
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3.3.2.7.1. String Replacement Editor 

Enter the string to find - the pattern match can be SIMPLE or REGEX depending on the Match 

Method property selected.  

Enter the value to be used as the replacement text and click OK to finish. 

 

3.3.2.8. Advanced Profile Settings 

Since web applications can be a combination of different development technologies, some 

Profiles may need some additional advanced configurations. For example, a web application can 

integrate JavaScript (interpreted) code while also calling an ActiveX control that runs outside the 

IE process model. Offering an array of options to developers with which to make their 

applications enables web development to be extremely powerful. Those same benefits can mean 

a specific application has unique and specific requirements. 

To help accommodate the unique scenarios that may be required, Ion offers additional 

behavioral and environmental controls using these options. As a rule, most web applications will 

work appropriately without modifying any of the entries or values in this area.  

Customers are encouraged to avoid adding, deleting or modifying the settings below unless 

directed by Browsium or an integration partner. Incorrect modification or deletion of the items 

here can result in unexpected and unwanted application behaviors. 



 

 

Browsium Ion 3.2 Administration Guide (Revision 04212014)  ©2014 Browsium Inc. 

50 

 

3.3.2.8.1. Content-type Whitelist 

The Content-type Whitelist feature is provided to address complex and unique web application 

scenarios that require uncommon data types. By default, Ion is designed to handle only those 

data types listed here. Any Content-type not included on this lit will be ignored by Ion and 

passed along to Internet Explorer for handling by the IE MIME type handler function. 

In the case where some environmental, string manipulation or other modification is required of 

a given Content-type, the value should be added here. Adding additional Content-types is easy. 

Simply find the ‘Click to add a new item…’ line, select that entry and begin adding the required 

value. The values in the Content-type Whitelist are freeform text, not selected from a list, so care 

should be taken to ensure spelling and syntax are correct or Ion will not function as expected. 

Customers are encouraged to avoid changing or deleting any of the pre-defined Content-type 

Whitelist entries. Incorrect modifications or deletions may result in Ion behaving unexpectedly.  

3.3.2.8.2. Ion Profile Flags 

Ion Profile Flags provide a mechanism to add additional functionality, logging and management 

capabilities without the need to update the Ion binaries. The feature is designed mainly for use 

in complex debugging scenarios. Certain Ion Profile Flag values can also be used to extend Ion 

functionality to meet an array of unique and specific edge case scenarios. Unless directed by 

Browsium or an integration partner, the Ion Profile Flags value should remain blank. 

3.3.2.8.3. Examine Web Requests 

Examine Web Requests determines when to send web requests and responses through the 

internal proxy for examination and content modification. ‘Always’ bypasses the routing logic and 

forces all traffic through the internal proxy. Auto allows Ion to decide and reduces proxy routing 

where possible. By default, Profiles are set to use ‘Always Examine Web Requests’ to ensure 

consistent application handling. 
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3.4. The Rules Manager Node 

The Rules Manager is the main interface for creating, editing and managing evaluation criteria 

for which content is to be rendered using Ion. This section contains details on the various 

elements and pieces of this interface. 

 

The Content Pane shows the hierarchical rules list that Ion uses to determine how to handle web 

application rendering. The heading for each column in this window refers to the specific rule 

element (e.g. Rule Name, Match Method, Value, Profile) for a given Rule. When no Rules are 

present, the Actions Pane only displays the ‘Add Rule’ link. As Rules are added the Actions Pane 

will display additional links to manage ordering and editing Rules.  

 

Add Rule - To create a new rule, click the Add Rule link in the Actions Pane to bring up the Rule 

Editor window. The next part of this section provides details on the options and values in the 

Rule Editor window. See the How to Create a Rule Section for details on creating rules. 

Edit Rule - URLs and rule definitions can be complex, and complexity may lead to typographical 

errors. In the event you make a mistake or need to revise a Rule, simply double click the line to 
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edit (or highlight the line and click the Edit Rule link in the Actions Pane) to make the necessary 

changes. 

Delete Rule - To delete a Rule, select it from the Rules Manager Window, then click the Delete 

Rule link in the Actions Pane. 

To disable a Rule rather than remove it, click the checkbox next to the Rule name  

Clone Rule - Some web applications or systems may require several related rules to function 

properly. The Clone Rule function is designed to aid in quickly creating rules that are similar to 

previously created Rules. The Clone Rule function can also help avoid having to copy/paste or 

manually retype a Rule that contains a long or complex URL. 

Move Rule Up/Move Rule Down - By default, rules are ordered in the sequence they are 

added. Since rules are evaluated in the order they are stored, the sequence of rules can be 

critical to the proper functionality of your web application in Ion. To manually adjust the order of 

a Rule, simply highlight the Rule and use the Up and Down buttons to move it to the proper 

placement. 
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3.4.1. Rule Editor 

The Rule Editor window is used for creating new Rules or editing existing Rules. 

 

Set Rule - All Rules are enabled by default when they are created. Some Rules may contain 

complex parameters or complex paths and it may be more practical to simply disable a Rule 

rather than remove it if the Rule is not needed or to test ordering patterns, etc. In addition, 

some users may choose to keep only a single Rule set and want to disable a specific Rule for 

some given period of time. To disable a Rule, select ‘Disabled’ from the dropdown list or click 

the checkbox next to the Rule name in the Rules Manager. 

Rule Name - You can name a rule using any characters without restriction or character count 

limit. Rule names are for your use and identification only, and have no impact on functionality. 

Browsium recommends using rule names that clearly describe what the rule is used for, so it can 

be easily identified in the Rules Manager display. 

 

Match Method – Most Rules require a simple pattern match of the URL in order to trigger Ion 

to manage the web application experience and load the required Profile. Some complex URL 

configurations require advanced pattern matching techniques, so Ion provides the ability to 

match based on regular expressions (RegEx) if needed. 

 

Value – This field should contain the string or integer to conditionally match in order to Ion to 

manage content rendering. 
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Profile - The Profile selection determines which browser Profile Ion uses to load the matching 

website. Any configured Profiles will be listed in this dropdown. In a default configuration there 

are no Profiles available. To change the Profile used for a given Rule, simply change the value in 

this field and save the configuration. 

 

3.5. The Project Settings Node 

The Project Settings node gives you the ability to edit global settings for Ion configurations that 

will be applied to all Profiles. These settings encompass features such as the Listener Service 

Port, Load from File Name parameters, and generic security and loading behaviors. 

 

3.5.1. Listener Service Port 

Port used by the Controller on the local machine. During startup, the Controller will check to see 

if the specified port is available. If that port is not available, the Controller will automatically 

increment the port value by 1 until an available port is identified. The default port value is 8877. 

3.5.2. Load Configuration from Local Machine Only  

By design, Ion configurations in the Current User (HKCU) registry hive take precedence over 

configurations in the Local Machine (HKLM) hive. Some organizations may want to prevent 

configurations in HKCU from overriding configuration in HKLM. By setting the Local Machine 

Only value to ‘Enabled’, Ion will only read configurations from HKLM. 
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3.5.3. Load from File Name 

Load from File Name is the path where the Flat File configuration file is on the local system or on 

a shared file location that the user has read access rights to. Refer to Flat File deployment 

section later in this guide for details regarding the use of a Local File Reference Project. 

3.5.4. Minimum Logging Level 

Ion records logging information to the standard Windows event log under an application-level 

source named ‘Ion’. The Logging Level setting determines the amount and type of data 

collected in the Windows event log. This table summarizes the various levels and data collected: 

Level Description 

Error Writes Error entries 

Warning Writes Warn and Error entries 

Info Writes Info, Warn and Error entries 

 

3.5.5. Show Splash Screen on Start 

Ion defaults to showing the Ion splash screen (Ion graphic with the product name and version 

number) on client systems when the Controller is started. The splash screen is only displayed at 

startup (usually set to user login) so users should not regularly see this display. This option can 

be disabled during project configuration. 

3.5.6. Clear Cache on Start 

By default, Ion will clear the Internet Explorer cache when the Controller starts and detects a 

configuration change since the last time it started. This is done to ensure proper rendering and 

eliminate any potential of older/stale files from being loaded via the system cache versus being 

obtained from the server. When files are loaded from the local system cache, Ion may be unable 

to properly manage the web application and cannot ensure configurations will work as 

expected. 
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3.5.7. Invalid Certificate Handling 

When presented with invalid HTTPS Certificates, Internet Explorer 6 did not generally warn users 

or prevent navigations. HTTPS Certificate handling behavior has become more secure in recent 

versions of Internet Explorer, such that invalid HTTPS Certificates will trigger blocked navigation, 

user prompts or related behaviors that prevent web applications from functioning as they did 

previously. Ion provides the ability to manage how invalid HTTPS Certificates are handled. 

Available options are: 

 

 Reject All: Rejects all invalid HTTPS Certificates and navigation is cancelled. 

 Accept All (Default): Accept all invalid HTTPS Certificates and continue with navigation. 
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3.6. The Tools Node 

The Tools Node was designed to provide a set of ‘helper’ applications for creating, testing and 

designing Profiles and Rules. Additional Tools will be added later, and can be installed by simply 

placing the specific DLL file in the directory with the Browsium Ion Configuration Manager. 

  

3.6.1. Process Monitor 

Ion includes Process Monitor (from Microsoft’s Sysinternals suite of tools) in the Tools Node to 

help administrators identify resources being loaded and referenced by a web application. 

Including Process Monitor eliminates the need for administrators to download and install 

additional applications for common web application troubleshooting issues. 

3.6.2. Regex Builder 

The Regex (Regular Expression) Builder is for administrators to create and validate complex 

Regular Expressions that can be used in the rules evaluation criteria.  
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The Regex Builder provides a simple integrated tool for writing and testing Regular Expressions 

before using them as rules evaluation criteria to help avoid errors in pattern matching.  

For more information on the Regex Builder, including a step by step example, please read the 

‘Using regular expressions in Ion rules’ document in the Knowledge Base section of 

http://support.browsium.com. 

  

http://support.browsium.com/
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Section Four 

Configuration Tutorial 

 

In this section you will learn: 

 How to Create a Profile 

 How to Create Rules in Ion 

 How to Remove Rules in Ion 

 How to Work With Custom Files and Registry Editor Options 
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4. Configuration Tutorial 

Once the Browsium Ion Configuration Manager installation is complete, you can begin 

configuring which sites to remediate with Ion using the Ion Configuration Manager. The Ion 

Configuration Manager is provided as a simple interface to create, delete and manage Ion 

behavior. As a security design, by default Browsium Ion only manages the settings for sites 

explicitly identified in the rule set, so you must create a rule or series of rules in order to use 

Browsium Ion. 

Systems must have the Browsium Ion Client installed to use the Rules and Profiles 

created in the Ion Configuration Manager. 
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4.1. How to Create a Profile 

Ion Profiles provide the ability to bind specific custom file system, registry and file settings to a 

specific rendering mode. Ion includes eleven Profiles templates that can be used to create 

Profiles: ‘Default’, ‘Adaptive IE Quirks’, ‘Emulate IE7 Mode’, ‘Emulate IE8 Mode’, ‘Emulate IE9 

Mode’, ‘Emulate IE10 Mode’, ‘IE Quirks Mode’, ‘IE Edge Mode’, ‘IE7 Standards Mode’, ‘IE8 

Standards Mode’, ‘IE9 Standards Mode’ and the ‘IE10 Standards Mode’. 

Any Profile can be modified to suit your needs after it is created, but the templates will remain 

unchanged. Some organizations may not need to make any customizations to the settings 

defined in the template, while others will require several changes to a Profile in order to make 

their web applications function properly. 

This table shows the specific browser engine version that will be loaded in each scenario: 

Document Mode  If IE8 is installed  If IE9 is installed If IE10 is installed 

Adaptive IE Quirks IE8 Quirks Mode or IE7 

Standards Mode (as evaluated 

by DOCTYPE) 

IE9 Quirks Mode or IE7 Standards 

Mode (as evaluated by DOCTYPE) 

IE10 Quirks Mode or IE7 

Standards Mode (as 

evaluated by DOCTYPE) 

Emulate IE7 Mode Emulate IE7 Mode for IE8 Emulate IE7 Mode for IE9 Emulate IE7 Mode for IE10 

Emulate IE8 Mode IE8 Standards Mode Emulate IE8 Mode for IE9 Emulate IE8 Mode for IE10 

Emulate IE9 Mode IE8 Standards Mode IE9 Standards Mode Emulate IE9 Mode for IE10 

Emulate IE10 Mode IE8 Standards Mode IE9 Standards Mode IE10 Standards Mode 

IE Quirks Mode IE8 Quirks Mode  IE9 Quirks Mode IE10 Quirks Mode 

IE Edge Mode IE8 Standards Mode IE9 Standards Mode IE10 Standards Mode 

IE7 Standards Mode IE7 Standards Mode for IE8 IE7 Standards Mode for IE9 IE7 Standards Mode for IE10 

IE8 Standards Mode IE8 Standards Mode  IE8 Standards Mode for IE9 IE8 Standards Mode for IE10 

IE9 Standards Mode IE8 Standards Mode IE9 Standards Mode IE9 Standards Mode for IE10 

IE10 Standards Mode IE8 Standards Mode IE9 Standards Mode IE10 Standards Mode 

 

The following steps demonstrate how to create a Profile based on the ‘Adaptive IE Quirks’ 

browser engine to render sites using an older version of Java. By design, Internet Explorer can 

only load the latest version of Java installed on the PC. This design is ideal for security and 

developer purposes, but it impedes the ability to ensure web application compatibility. This 

example will illustrate how to create a Profile to load Java 1.4.2 update 19 (1.4.2_19) instead of 

the newer Java 1.7 update 40 (1.7.0_40) version installed on the system.  
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Additional information on this topic, including information on running other 

combinations of Java or how to run the MSJVM can be found online at 

http://support.browsium.com in the “Managing Java with Ion” document. 

1) Open the Ion Configuration Manager. Since no Rules or Settings are loaded by default, 

you will need to create a New Project, Open a saved Project or Load Local Settings from 

under the File menu. If this is the first time you have loaded the Ion Configuration 

Manager you will have no Project files or local settings on your system so you would 

create a New Project. 

 

 

 

2) Click on the Profiles Node, then click the ‘Add Profile’ link in the Actions pane (or right-

click on the Profiles Node and select ‘Add Profile’) to open the Select Rendering Mode 

screen: 
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Select the Rendering Mode needed for your web application and click ‘OK’. If you are 

unsure which Rendering Mode to use, Browsium recommends starting with the Adaptive 

IE Quirks Mode for legacy web applications. With newer web applications you can start 

using the latest available Rendering Mode and then working backwards as needed. 

 

3) Enter a name and description for the new Profile. The name and description fields are for 

reference purposes only and can be anything useful or meaningful to your organization 

and environment. Profile Names and Descriptions can be changed at any time. 

 

 

 

 

The Profile will be pre-populated with the most commonly needed settings for the 

specified Profile. Changes to these values can be made at any time. 
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4.2. How to Create a Rule 

Ion provides several options for rule matching in order to meet the specific needs of your 

environment. In this example we have identified a website, http://www.aggrid.com, which is not 

compatible with IE8, so we need to make a rule to enable Ion when users visit that web 

application. 

The easiest way to create a Rule using the Profile you just created is to use the ‘Add Rule using 

this Profile’ link in the Actions pane. Rules can also be created using the following steps: 

1. Click the Rules Manager Node, and then click the ‘Add Rule’ link in the Actions pane to 

bring up the Rule Editor window. 

 

 

See the Rule Editor section for more information on each setting.  

Keep the Set Rule value as Enabled in order to make this Rule active for use. Enter a 

name for the Rule. Rule names are friendly names for organizational and identification 

purposes only and have no effect on the behavior of a rule. For this example, we will 

choose “Ion Demo Site”. 

 

2. There are two Match Method options for ensuring the Rule is triggered when desired 

conditions are met. The Simple method does a simple pattern match within the 

requested resource, and the RegEx method is provided for scenarios that require a set of 

complex matching criteria. Most Rules will only need the Simple method. For this 

example we will leave everything set to the default. 

http://www.aggrid.com/
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3. Enter a Value to check for Rule matching conditions. For this example we will use the 

domain name for our application - aggrid.com. 
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4. If you used the Action pane link to create this Rule, the Profile is already defined. 

Otherwise simply choose “Adaptive IE Quirks Mode Profile” as the Profile for this rule. 

 

 

 

 

 

5. When you are done creating the Rule (or changing a setting), remember to click the ‘OK’ 

button to save the Rule to the Rules Manager. 

 

6. You can continue to add Rules until you have completed all the desired entries.  

 

7. Rules and configurations can be saved either as Local Settings or Project files.  

Projects should be saved regularly to ensure work is not accidently lost. Ion 

Configuration Manager does not auto-save work in progress.  

Saving as Local Settings will apply the rules and configuration to the machine instantly, 

whereas saving the Project file would not apply those rules now but enable you to load 

them later or pass them to another machine. For this example, we’ll use the Save Local 

Settings option under the File menu. 
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In order to save the Ion configuration files to the local system, the user may need to click 

‘Allow’ on the process elevation request. 

 

8. Once the settings are saved, simply open your browser and browse to the site that 

satisfies the rule you have just created.  
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4.3. How to Remove a Rule 

Rules are easily removed using the Browsium Ion Configuration Manager when it is no longer 

needed. In this example, assume we have taken the needed steps to mitigate the compatibility 

issues with the web application running on www.aggrid.com, so we no longer need to display 

the site using Ion. 

You can remove a rule by following these steps: 

1. Open the Ion Configuration Manager and load the Project containing the Rules you want 

to remove (using either Load Local Settings or Open Project from the File menu). With 

the Project loaded, click the Rules Manager node to bring up the ordered list of Rules. 
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2. Select the Rule you wish to remove from the list of Rules. 

 

 

 

 

3. Click the Delete Rule in the Actions pane. 

Remember to save the configuration using the File menu (either as a Project File or 

Local Settings) before closing the Ion Configuration Manager to ensure the deleted 

Rule is actually removed from your configuration. For organizations using Group 

Policy to manage configurations, you will need to export the new settings and 

push out the changes to ensure clients are updated. 
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4.4. Working With Custom Files, Registry Settings and ActiveX 

Controls 

One of the most powerful features of Ion is that it lets you use files and settings other than 

those traditionally installed on the PC. This is accomplished, in part, by creating additional Ion 

profiles.  

To illustrate how this feature works, the example in this section uses the Browsium demo 

website, “aggrid.com”, which worked properly in IE6 and is also incompatible with the latest 

version of Java. To accommodate this site, create a Profile and include a Custom ActiveX control 

setting to load the older, compatible version of the Java Runtime Environment. 

The example used here (requiring Java 1.4.2_19) shows an ActiveX control setting that requires 

only one file, but it is important to understand Custom ActiveX controls may be comprised of 

several files (either .OCXs and/or .DLLs) as well as a range of registry entries.  

Visit the Browsium support site (http://support.browsium.com) for more 

information on settings and guidance for commonly requested controls. 

The following steps demonstrate how to create the configuration needed to solve the Java 

compatibility issues on the “aggrid.com” site: 

1) Create a Profile (This example uses the name “Java 1.4.2_19 & IE Adaptive Quirks”) using 

the process outlined in the How to Create a Profile section, then select the Custom Files 

Manager from under the Profile node. Click the ‘Add Custom File’ link in the Actions 

pane to will bring up the “Custom File Editor” window where you need to identify the 

source and target files for Ion to manage.  

http://support.browsium.com/
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2) The Source File is the item needed for your application – in this case the Java 1.4 file 

(NPJPI142_19.dll). Either manually enter the path of the file or select it by clicking the ‘…’ 

button to open the file dialog. The required .dll can be found under the “bin” directory 

where Java was installed. 

 

 

 

Highlight the desired file and click ‘Open’ to select it. 
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The location and filename will be entered in the Source File text box. 

 

3) The Target File is the file to be overridden – in this case Java 7 file (JP2IEXP.DLL). Either 

manually enter the path and location of the file or select it by clicking the ‘…’ button to 

open the file dialog. The Target File can be found under the “bin” directory where Java 7 

was installed. 

 

  

 

4) Leave the ‘Register ActiveX Control/COM?’ set to ‘Disabled’ and select ‘OK’. 
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5) Your Custom Files Manager window should now show something like this: 

 

  

 

Now you need to create a Rule to instruct Ion to automatically render the “aggrid.com” 

site using this Profile. To get started, click the Rules Manager node. 

 

1) Click the ‘Add Rule’ link in the Actions pane. 

 

  



 

 

Browsium Ion 3.2 Administration Guide (Revision 04212014)  ©2014 Browsium Inc. 

74 

2) Give the rule a friendly name (e.g. ‘Aggrid.com with Java 1.4’), leave the Match Method 

set to Simple and enter ‘aggrid.com’ in the ‘Value’ field. Finally, select the Profile we 

previously created from the ‘Profile’ dropdown: 

 

3) Click ‘OK’ to add this Rule to the list:  
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4) Your Rule and Profile are now ready to use. Select ‘File’ from the menu bar, then ‘Save 

Local Settings.’ 

 

  

4.4.1. Java Version Manager 

This Ion release introduces a new Java Version Manager wizard to make it easier for 

organizations to manage Java versions with Ion. The Java Version Manager can be used instead 

of manually creating the required Custom Files entries. This example uses the Java Version 

Manager to automatically create the same Custom Files entries as were done in the previous 

example. 

 

The Java Version Manager loads options available on the machine with the Ion 

Configuration Manager installed. The file locations used by the Java Version 

Manager will be based on the locations of Java on that machine. If the location of 

Java files on the target/client system does match the system running the Ion 

Configuration Manager, the entries will need to be manually modified to the 

proper paths and filenames in order to ensure the Java versioning works properly. 

1) Launch the Java Version Manager by clicking the ‘Java Version Manager’ link in the 

Actions pane.  
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2) Since the aggrid.com web application requires Java 1.4.2 update 19, simply select that 

from the dropdown list and click OK. 
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3) After completing these steps you should have the following entry in the Custom Files 

manager screen: 

 

  

The Java Version Manager will use the %ProgramFiles% environment variable 

rather than a fully qualified path to help avoid issues where end user systems may 

have different configurations – particulalry 32-bit vs. 64-bit Windows. 
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Section Five 

Rule Writing Basics 

 

In this section you will learn: 

 Recommendations for Rule Writing 

 Using Test Mode for Instant Testing 

 How Rules and Settings are Applied with Ion 

 How Ion Keeps Users Secure Through Admin-only Configurations 
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5. Rule Writing Basics 

You completely control the Ion experience. No rules are included ‘out of the box’. There is 

nothing hidden from you and Ion does not make any decisions for you. We can, however, 

provide some guidance on writing rules that might work effectively for your organization.  

For security purposes, we have designed Ion not to interfere with content that fails to match a 

declared Rule. This opt-in model prevents unwanted content from being displayed using 

anything other than the standard Internet Explorer experience. While the Ion design increases 

security and protects both systems and users from inadvertently loading malicious content, 

unmatched rule content can still be displayed. 

5.1. Recommendations for Writing Rules that Work Well 

Ion was designed so users browsing the web are unaware anything ‘special’ about the content 

they are viewing and to remove from users the burden of ensuring line-of-business applications 

‘just work’. This is the key to a successful experience. Users should not be concerned with the 

browser rendering engine that they are using with line-of-business applications and websites. 

Anything else can disrupt and interfere with workflow and efficiency. When writing rules with the 

Ion Configuration Manager, there are some things to take into consideration that can help your 

users have a better experience. 

Many organizations have just begun to assess which applications and websites are incompatible 

with newer versions of Internet Explorer. Without a detailed review of which applications need 

remediation, organizations may look at building broad sets of Rules. Most internal web 

applications are accessed on a few defined hosts, at first, you may want to write a Rule that 

covers all of these hostnames. This will help ensure that all your internal web applications render 

as they have in previous versions of Internet Explorer. Over time, you can build a library of rules 

that cover the specific web applications which either do not work with later versions of the 

browser or still need to be tested. Then, you can remove the overarching hostname rule so that 

the specific rules apply.  
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5.2. Working with Web Application Assessment Tools 

While Ion provides a solution for Web Application Continuity issues, you must create a rule set 

to make your line-of-business applications function properly. For organizations that have been 

actively assessing application compatibility issues in their environment, making the rules list can 

be relatively straightforward. For organizations just starting their assessment efforts, making the 

rules could prove complex – use broad rules sparingly and they should be short-term solutions 

used while more in depth assessment is performed. 

5.3. Ion Rules Behavior 

Since Ion uses a Rule-based opt-in model, the ordering of Rules is critical to ensure web 

applications function properly. The Ion design allows an organization to manage configurations 

in either centralized or distributed models. If a centralized team manages the configuration, 

there is less likelihood of overlapping configurations. Organizations that distribute configuration 

settings to various business units or web application teams may encounter conflicting 

configurations. In these instances Ion will always use the ‘Last In, First Out’ (LIFO) method, 

meaning that newer configuration values will overwrite previously read values for the same 

name.  

For organizations using Group Policy and multiple Organizational Units, similar logic applies. For 

example, if all company users receive one set of rules defined by the corporate IT department, 

and a non-overlapping configuration is only applied to members of the Finance department, the 

two sets of configurations will simply be additive, giving Finance users a larger set of rules than 

other company employees. If there is a conflict, LIFO applies again and whatever rules were read 

last will overwrite previous values. 

In addition to the process outlined here, specific examples and step by step directions for 

managing Ion with Group Policy can be found online at support.browsium.com. 
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5.4. Why Users Can’t Create Their Own Rules 

Only Administrative installs of Ion are capable of creating rules. The justification for this design 

boils down to a simple reason: security. 

Older web applications and ActiveX controls were not designed with modern exploits in mind 

and may not be updated as frequently as their newer counterparts (or at all, in the case of end-

of-life software). That’s why it’s important to run modern, up-to-date software for normal, 

everyday web browsing. Ion helps organizations do just that, allowing them to migrate to the 

latest platforms while continuing to use the legacy software on an as needed basis. 

A user faced with an incompatible web application might be tempted to use Ion excessively or 

even exclusively. But running Ion to render like IE6 and exposing outdated ActiveX Controls to 

the Internet just isn’t a good idea.  

Compatibility problems are frustrating and incur a cost to users’ productivity. Since users are not 

given a way to enable Ion manually to ‘fix’ something that appears to be broken, we encourage 

companies to use existing support feedback mechanisms, such as helpdesk or support 

escalation systems, to give users ways to provide feedback and get new sites added to the Ion 

rules lists. 

 

Ion does not install any legacy Internet Explorer components that may be exploited 

by a malicious site or application. Installing Ion will not add any potentially 

exploitable legacy Internet Explorer software. The Ion design simply manages how 

Internet Explorer renders content and the environment in which it runs. If a web 

application requires removing or lowering security settings present in the newer 

version of Internet Explorer you are running, those changes will be restricted to the 

pages loaded by sites that are defined by Rule. 
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Section Six 

Managing Ion in the Enterprise 

 

In this section you will learn: 

 Enabling the Ion Client in the enterprise 

 Using Ion with Flat File Configurations 

 Using Ion with Group Policy 
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6. Ion Deployment in the Enterprise 

Ion supports a variety of methods for deploying configurations (Ion Profiles, Rules, and Settings) 

to PCs in an enterprise. In this section, we’ll examine these methods and provide 

recommendations and specific deployment guidance for typical enterprise scenarios. 

Ion configurations can be deployed across an enterprise via two methods: 

1) A Flat File which contains the entire configuration, formatted as XML, pushed out to a 

known location on end user PCs or a shared network location; or 

2) Serialized registry keys, where the entire configuration is stored in a set of registry keys 

which are deployed to end users via Group Policy.  

Though the Flat File option doesn’t require Group Policy, it does require a pointer to the 

configuration file in the registry of all end user PCs. The registry preference extension for Group 

Policy is often the most efficient way to streamline the deployment of this registry key and value. 

Before we look at Flat File and serialized registry deployments, it is important to understand 

methodologies for deploying configurations on test systems during configuration development. 

Ion makes it easy to test a configuration without requiring a centralized deployment 

methodology. This is done via the Save Local Settings option from the File menu of Ion 

Configuration Manager.  

This option will deploy the configuration into the Windows registry in either the 

HKEY_CURRENT_USER or HKEY_LOCAL_MACHINE hive (depending on the option selected), 

immediately restart the Controller to read the configuration, and enable iterative testing of the 

Profiles, Rules, and Settings without a tedious enterprise deployment process. This method 

should only be used for testing as it requires manual operation of Ion Configuration Manager 

which should never be made available to end users.  

The last concept that must be understood before embarking on an Ion deployment is the 

precedence hierarchy for the evaluation of configurations when multiple configurations are 

found on a system. Ion follows this hierarchy to load the configuration that will be used on a 

given end user system (and on test systems). Once a valid configuration is found, Ion will stop 

searching and that configuration will be used.  

Deploying different Ion configurations using multiple methodologies on a single 

PC may cause unpredictable results as only the configuration highest in the 

hierarchy will be in use. 

 

http://technet.microsoft.com/en-us/library/cc771589.aspx
http://technet.microsoft.com/en-us/library/cc771589.aspx
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The following table provides the hierarchy of Ion configuration precedence. The string 

“(Wow6432Node)” in the registry path denotes the Wow6432Node registry key that will be 

included in the path on 64-bit Windows systems. 32-bit Windows systems do not contain this 

key, hence the use of parentheses in the example. 

 

 

Two additional locations can reference Flat Files in LoadFromFileName for Ion. These are 

HKEY_CURRENT_USER\Software\Browsium\Ion\Settings\LoadFromFileName and 

HKEY_LOCAL_MACHINE\Software\(Wow6432Node)\Browsium\Ion\Settings\LoadFromFileName. 

However, these locations are not robust as they are deleted from the registry when Ion is 

uninstalled (which may occur during a version upgrade). Browsium recommends using the 

Policies key for Flat File deployments, whether via Group Policy or a registry script. More on this 

in section 6.3. 

  

HKEY_LOCAL_MACHINE\Software\(Wow6432Node)\Policies\Browsium\Ion\Settings\LoadFromFileName

(Flat File pointer for all user accounts, deployed via Registry Editor or Group Policy)

HKEY_LOCAL_MACHINE\Software\(Wow6432Node)\Policies\Browsium\Ion

(Serialized configuration in registry for all user accounts, deployed via Group Policy)

HKEY_CURRENT_USER\Software\Browsium\Ion

(Serialized configuration in registry for single user testing, deployed via Save Local Settings)

HKEY_LOCAL_MACHINE\Software\Browsium\Ion

(Serialized configuration in registry for multi-user testing, deployed via Save Local Settings)
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6.1. Enabling the Ion Client for Enterprise Deployment 

A critical element of any Browsium Ion deployment is ensuring the Ion Client Add-on is set to 

‘enabled’ in Internet Explorer on all client PCs. Recent versions of Internet Explorer require user 

confirmation before any new add-on is enabled, unless that add-on is set to ‘enabled’ during 

the deployment process. In this section, you will learn the procedures for centrally enabling the 

Ion Client Add-on during deployment. 

The most common way to enable the Browsium Ion Client Add-on during deployment is by 

utilizing Group Policy to make the necessary registry changes on client PCs. Alternative methods 

to modify the registry on client PCs, such as a Visual Basic Script, can also be employed. The 

following guidance is adapted from articles on Microsoft’s TechNet website, and includes the 

process to identify the GUID/CLSID of the Browsium Ion Client Add-on, which must be located in 

the Registry once it is installed in your environment. 

6.1.1. Understanding the Add-on List Policy  

Administrators can control the use of specific add-ons in Internet Explorer through the Add-on 

List Policy. Administrators can choose to enable or disable an add-on as well as allow a specific 

add-on to be managed by the user. 

Policy Name: add-on list 

Path: User Configuration or Computer Configuration node; Administrative Templates\Windows 

Components\Internet Explorer\Security Features\Add-on Management. To set this policy, an 

administrator can enable the policy and enter the GUID/CLSID of the Ion add-on to the Add-on 

List and set the value to 1. 
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To manually set this policy, an administrator can create a registry value based on the 

GUID/CLSID of the add-on in either of the following keys and then set the desired value: 

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Ext\CLSID  

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Ext\CLSID  

Each add-on is a value in this Registry key with the following properties. 

Name: GUID of add on 

Type: REG_SZ 

Value: 

0 - Add-on is disabled and cannot be managed by the end user. 

1 - Add-on is allowed and cannot be managed by the end user. 

2 - Add-on is allowed and can be managed by the end user. 

The Add-on (CLSID) lists are empty by default.  
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6.1.2. Determining the GUID/CLSID of the Ion Client Add-On 

After installing the Browsium Ion Client, go to the Tools menu in Internet Explorer and choose 

Manage add-ons. 

 

You’ll then be presented with the Manage Add-ons interface where you should see Browsium 

Ion Client Add-on in the list among the Toolbars and Extensions that are currently loaded in 

Internet Explorer. 

 

Right Click on the Browsium Ion Client Add-on and choose ‘More information’ from the 

dropdown menu. 
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The Class ID (CLSID) will appear in the dialog box.  

 

Click the “Copy” button and then paste the contents of this dialog box (including the Class ID) to 

Notepad for later reference and save the text file. When you make the registry changes 

documented above, you will need to use the Class ID to identify the add-on in the Registry. 

More information, including troubleshooting techniques, can be found on the Microsoft 

TechNet website in the article Internet Explorer Add-on Management and Crash Detection. 

 

  

http://technet.microsoft.com/en-us/library/cc737458(v=WS.10).aspx
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6.2. Readying End User PCs to Use the Ion Client 

After you have deployed the Ion Client (Ion-ClientSetup.msi) to your end user PCs, it is very 

important to follow a few steps to ensure the Ion software is running and ready to process the 

Profiles and Rules contained in your Ion configuration.  

In addition to ensuring that the Ion Client Add-on is enabled, per the guidance in section 6.1, 

the Ion Controller process must also be running. The Ion Controller does not start automatically 

after installation of the Ion Client, even if an Ion configuration is present. The Ion Controller can 

be started by restarting the client computer (and will start automatically upon every login) or by 

manually starting CovController.exe found in the %ProgramFiles%\Browsium\Ion directory.  

 

If this latter method is used, all Internet Explorer windows must be closed before the Ion 

configuration will take effect.  

If the Ion Configuration Manager has been installed, it can be used to start and restart the 

Controller as required – also requiring Internet Explorer windows to be closed. This method 

should only be used on systems run by administrators trained in creating and modifying Ion 

configurations. 
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6.3. Deploy Ion Configurations via the Flat File Method 

Since Ion is a client solution with no server component, getting the configuration settings to the 

client is critical for proper operation. Configuration management is extremely flexible and can be 

tailored to meet the design and requirements of your environment.  

Browsium recommends that Ion configurations be deployed via Flat File. Configurations are 

standard XML documents, allowing you to take full advantage of this versatile and very compact 

format. Configurations are easy to update by simply replacing the Flat File on end user systems 

or a network share. This is in contrast to deploying configurations serialized in the registry via 

Group Policy (detailed in section 6.2) which adds unnecessary complexity and limitations to 

managing an Ion deployment. 

However, Ion will not look for a Flat File configuration by default. You must configure each client 

system to look for a Flat File configuration. But this only needs to be done once, no matter how 

often the Flat File is updated – provided the file name and file location is not changed. The 

following steps provide guidance to enable Ion to read its configuration from a Flat File. 

There are two methods for loading the Ion configuration file using the Flat File method. The first 

method involves editing the system registry manually or with a script with your software 

distribution tools. The second method involves using a minimal Ion configuration file that is 

deployed to client systems via Group Policy and contains nothing more than the path to the Flat 

File configured on the Settings node. This latter method, described in section 6.3.5, should be 

used if you are not comfortable making registry changes to the local systems.  

6.3.1. Save Project File (XML Flat File) 

Regardless of the method selected for instructing Ion to use the specified ‘Flat File’ 

configuration, the Project file must be saved for distribution: 

1. Open the Ion Configuration Manager and ensure the desired Project is loaded. Click the 

File menu, and then select ’Save Project’ (or ‘Save Project As’). 
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2. Choose a location to save the project file. This XML file becomes your Ion Configuration 

File which the systems will interact with to invoke the Profiles and Rules that Ion uses to 

control how Internet Explorer will behave. 

 

 

 

3. (Optional) While you can open your XML project file for inspection using Notepad or 

other text editors, you should not edit the file in those applications. The screenshot 

below is what a file will look like when viewed in a text editor. 
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Browsium does not recommend using anything other than the Browsium Ion 

Configuration Manager for editing Rules and Profiles, unless directed to do so by 

Browsium Support. 

4. Use your preferred method of software distribution to propagate the Flat Files to the 

end-user machines, but be sure to follow the process outlined in the Load Configuration 

from File section to ensure proper management of Ion with Flat Files.   
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6.3.2. Flat-file Deployment Option A: Single Registry Entry  

In this section you will learn how to instruct Ion to load the configuration file you just saved 

using the Flat File method. To do this, you must edit the system registry manually (for local 

testing) or via a script or Group Policy (for remote deployment). Browsium recommends using 

the registry preference extension for Group Policy as the most efficient way to streamline 

deployment of this registry key/value. 

The Ion project file (.bcx) must be stored in a user-readable location on the local PC or a 

network share – local PC recommended as Ion will not start if the network is unavailable at user 

logon. You will enter that specific location in the LoadFromFileName registry value. The 

LoadFromFileName registry value is only available for per-machine settings (which will enable 

the configuration for all user accounts on the system).  

Loading a configuration from a network location will cause the Ion Controller to 

not start if the network share is unavailable at user logon. 

The following registry keys and associated values must be created, depending on the system 

and user accounts being targeted: 

For per-machine settings on 32-bit Windows systems, find or create: 

HKEY_LOCAL_MACHINE\Software\Policies\Browsium\Ion\Settings 

For per-machine settings on 64-bit Windows systems, find or create: 

HKEY_LOCAL_MACHINE\Software\Wow6432Node\Policies\Browsium\Ion\Settings  

Then create or populate the following String Value in the Settings key: 

LoadFromFileName (REG_SZ) = C:\directory\… [the path to your Ion project file (.bcx)] 

This setting will direct the Ion software to the configuration file the next time the Ion Controller 

is restarted. 

Slashes in the file path must be escaped with a slash when invoking Regedit.exe via 

a .reg file. So C:\directory becomes C:\\directory in the registry value. Similarly, 

\\server\share becomes \\\\server\\share. 

In this example, LoadFromFileName has been configured to use the file “Aggrid in 

IE10.project.bcx” in the C:\Ion directory on a 64-bit Windows system. These entries can be 

scripted and delivered to the Registry on remote clients via the following text in a .reg file. 

Windows Registry Editor Version 5.00 

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Policies\Browsium\Ion\Settings] 

http://technet.microsoft.com/en-us/library/cc771589.aspx
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"LoadFromFileName"="C:\\Ion\\Aggrid in IE10.project.bcx" 

 

 

6.3.3. Flat-file Deployment Option B: Reference Project 

To instruct Ion to load configurations from a local file instead of the registry or policy values, 

you can create two Projects – a complete project, and a second containing only a single 

reference to the location of the first project file (defined in the Load from File Name field in the 

Project Settings node). This project file is called the Local Reference Project File. The path 

location value for the ‘actual’ Project file can be hardcoded or declared with a system variable 

(using the %VariableName%) format notation. Use Group Policy to deploy the Local Reference 

Project File to user systems. Use the preferred process for your organization to deploy the 

‘actual’ Project file, (The one specified in the Load from File Name field in the Project Settings 

node of the Local Reference Project File) to the specified location. 

For organizations that do not use Group Policy, you may use the ‘Save local Settings’ option in 

the File menu to save the ‘local file reference’ project values to the registry of the administrator 

workstation. Once the values are saved to the local system, export the registry values from the 

location chosen in the ‘Save Local Settings’ dialog box (either ‘Current User’ or ‘Local Machine’). 

Be careful to clear the LoadFromFileName value when saving the Project file 

containing the actual configurations and settings that will be loaded by Ion. Failing 

to clear the values properly could result in circular configuration loading attempts. 
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6.4. Deploy Ion Configurations via Serialized Registry Keys 

Using serialized registry keys to deploy Ion configurations requires the creation of ADM or 

ADMX files that contain the Ion Profiles, Rules, and Settings. These will then be used by your 

Group Policy infrastructure to push the configuration to end user PCs. 

Browsium recommends deploying Ion configurations using Flat Files and not 

serialized registry keys due to limitations and complexity of the ADM and ADMX 

architectures. This feature will be deprecated in an upcoming release of Ion. 

Creating the ADM or ADMX files containing the Ion configuration can be easily done within the 

Ion Configuration Manager. After creating and testing the Ion project, export the project by 

selecting “Export to ADM...” or “Export to ADMX…” from the File menu. 

                        

 

You will choose between using ADM and ADMX depending on the Windows, 

Windows Server, and Active Directory environment within your organization. 

Microsoft has published detailed guidance to help you decide.  

 

For the purposes of this guide, we will assume you have chosen ADM. 

Once you have exported and named your ADM file, transfer the file to a Domain Controller or a 

system running Group Policy Manager. 

 

Launch the Group Policy Manager, create a new Group Policy Object and set permissions to it. 

 

http://technet.microsoft.com/en-us/magazine/2008.01.layout.aspx
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Right click the newly created Group Policy Object, select ‘edit’ to launch the Group Policy Editor.  

 

 

 

Open the Computer Configuration > Policies node, then right click on Administrative Templates 

item. Choose the Add/Remove Templates option and select the ADM file exported from the Ion 

Configuration Manager above. 
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Now expand the Classic Administrative Templates folders under Machine and User 

Configuration and expand the Ion Folder. You will see a series of folders. Open up each item in 

these folders and Enable them.  

Ion Policies are not enabled by default. They must be ‘Enabled’ individually. Use 

the ‘Not Configured’ setting if you do not want to use one or more of the Profiles 

or Rules.  

In addition, always make changes to Profiles, Rules and Settings in the Ion 

Configuration Manager and not in the Group Policy Editor. 

As soon as your policies are updated on client systems, and the Ion Controller is started, your 

Ion configuration will be in effect. It is possible to script the starting of the Ion Controller, but 

the script must run in User, not System, context. Browsium recommends restarting the systems 

or waiting until the next time users log into their systems. The Ion Controller starts automatically 

upon login, provided it finds a valid configuration within the hierarchy. See the opening of 

section 6 for a refresher on the Ion configuration hierarchy. 

6.4.1. A Few Words About ADMX 

If you’ve chosen to deploy with .ADMX files instead of .ADM files, you’ll need to alter your 

deployment steps as follows: 

Once you’ve completed the ADMX export, you will have two files – <filename>.admx and 

<filename>.adml. Rename these files for your needs and copy them to a Domain Controller. 

On the Domain Controller, place the ADMX file in C:\Windows\PolicyDefinitions. Place the ADML 

file in C:\Windows\PolicyDefinitions\en-US. Placing the files in these locations will automatically 

create a new template within your Group Policy Manager. 

Launch the Group Policy Manager and locate the Ion folder within the Default Domain Policy 

under Administrative Templates: Policy Definitions (ADMX files). Open up each item in these 

folders and set them to ‘Enabled’.  

Ion Policies are not enabled by default. They must be ‘Enabled’ individually. Use 

the ‘Not Configured’ setting if you do not want to use one or more of the Profile or 

Rules. Setting the value to Disabled may cause unexpected impacts on client load 

behavior. 

As with ADM, your policies will now be pushed out to end user systems and your Ion 

configuration will be in effect the next time the Ion Controller is started. 
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Appendix A 

Appendix A: Troubleshooting 

 

In this section you will learn: 

 How to Recognize Issues with an Ion Configuration 

 What to do When Ion is Not Working as Expected 
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A. Troubleshooting 

A.1. Ion Rule Fails To Engage 

You may encounter a scenario in which Ion fails to engage on one or websites based on rules 

created. 

The following points may guide you to a resolution: 

 Review System Prerequisites 

o Check to see that the target computer meets the performance and storage 

requirements to run Ion. 

o Confirm that .NET 3.5 is installed on the computer running the Ion Client 

installation.  

 

 Verify the Ion Installation Files 

o If you are using a computer where both the Ion Configuration Manager and Ion 

Client are present, ensure that they are installed and running. 

o If you are using a computer where only the Ion Client is installed, verify that it is 

correctly installed and running. 

 

 Ensure Matching Versions of the Ion Configuration Manager and Ion Client are 

Installed 

o If you installed previous versions of Ion, make sure that you are using the Ion 

Configuration Manager for which the Major, Minor, and Update numbers match 

that of the Ion Client currently installed on a target machine. 

 

 Confirm the Ion Executable Files are Running 

o Check to see that the Ion Controller (CovController.exe) is running on the 

target PC. 

o Verify the Ion Broker process (CovBroker.exe) is running when a Rule has been 

invoked. 

 

 Ensure the Ion Plugin is Enabled and Running  

o  Confirm the Browsium Ion Client Add-on is seen and loaded by Internet Explorer 

 Open Internet Explorer and open the Manage Add-Ons dialog. Do you 

see the Browsium Ion Client Add-on installed? Is it enabled? 
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 An Internet Explorer instance that correctly loads the Ion Client will display 

the following information in the Manage Add-Ons dialog: 

 

 

 

 

 

 Visit the Forums or Contact Support 

o If all of these steps fail, consider posting a question on the Browsium Support 

Forums. 

o If you have a support evaluation or contract, contact your service integrator, or 

the Browsium Support team for one-on-one guidance 

A.2. Correct Profile Does Not Load for a Web Site 

If you are experiencing an issue where a specific Ion Profile does not load for one or more web 

sites, the following steps may help resolve your issue. 

1. Check that you have Rule covering the website or web application in question. 

a. If testing locally, make sure you have saved the current settings to the Local 

Machine or Current User 

 

2. Open the Task Manager and check that the CovController.exe (Controller), the 

CovBroker.exe (Ion Broker) processes are running.  

 

3. In Internet Explorer, open the Manage Add-Ons window, and check that the Browsium 

Ion Client Add-on is enabled. Your configuration should match the configuration in the 

screenshot below: 
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A.3. Ion Not Working Properly in IE6 or IE7 

Browsium Ion is only supported on Internet Explorer 8, 9, 10, and 11, so you may see 

unexpected behavior when trying to install and run Ion with other versions of Internet Explorer.  

 


